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About BitCurator
The BitCurator Environment is a Ubuntu-derived Linux
distribution geared towards the needs of archivists and
librarians. It includes a suite of open source digital
forensics and data analysis tools to help collecting institutions
process born-digital materials.
The BitCurator environment is distributed as a VM that can be
run in VirtualBox, and as a Live ISO that can be used to install
BitCurator on a dedicated host machine.
We recommend that you run BitCurator on a dedicated
machine in production environments by installing from the
Live ISO image.
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What this Document Covers
•

•
•
•
•
•
•

How to run the BitCurator environment as a virtual machine in
VirtualBox, and how to install the BitCurator environment using the Live
CD image
Generating reports on file system contents
Using DFXML metadata to characterize the contents of file systems
contained in disk images and raw media devices
Exporting file system metadata, and files from disk images and live
media
Locating and processing sensitive and personally identifying information
within digital materials (using bulk_extractor)
Understanding the main data elements that are generated by open
source forensics tools (using DFXML)
Other useful tools included in the BitCurator environment
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How To Use This Document
• Planning on running BitCurator in VirtualBox using the
existing VM?
– Use the instructions on Pages 5-15
• Planning on installing BitCurator using the Live ISO image?
– Use the instructions on Pages 16-19
• General instructions regarding using the tools in BitCurator
begin on Page 20
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Getting Started with the Virtual Machine
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Getting Started with the Virtual Machine
• Hardware:
– Desktop or laptop with an Intel Core i5/i7 (or similar) processor running
64-bit Windows 10, Mac OS 10.12 (or newer), or a 64-bit Linux variant.
– 8GB RAM or more
– 12GB free hard disk space minimum. The virtual machine is approximately
9GB. It will expand to 256GB as needed.

• Software:
– BitCurator VM or Live CD:
https://github.com/BitCurator/bitcurator-distro/wiki/Releases
– Current release of VirtualBox:
https://www.virtualbox.org/wiki/Downloads
– VirtualBox Extension Pack.
• Must be installed on the host for USB 2.0/3.0 support. Download and double-click
on the file once you’ve installed VirtualBox. The link is just below the main
download on the page linked above.
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Unpacking the BitCurator Virtual Machine
• The BitCurator Virtual Machine is packaged as a tar archive and
compressed with gzip. The file will look something like: “BitCuratorX.X.X.tar.gz”
• On a Mac (OS X 10.10 or later) or Linux host machine, you can simply
double-click on the file to unpack the contents. On a Windows
machine, you may need a 3rd party utility such as 7-zip:
http://www.7-zip.org/download.html
• When using 7-zip, you’ll need to unpack the .tar.gz file. Right click on
the .tar.gz file and select “Extract here…” to extract the .tar file. Then
right click on the .tar file and select “Extract here…” again. This will
extract a directory containing the BitCurator virtual machine disk
image (.vbox) and configuration (.vdi) files.
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BitCurator Virtual Machine Files
• Once you’ve unpacked the archive, you’ll find a directory
containing two files (where X.X.X is your downloaded version):
§ BitCurator-X.X.X.vbox (the VirtualBox configuration file)
§ BitCurator-X.X.X.vdi (the VirtualBox disk image)
• Copy this directory to a location of your choosing (inside the
“VirtualBox VMs” directory in your home directory is a good
place), and start up VirtualBox.
• Tip: If you’ve never created or used a VM in VirtualBox before,
you won’t have a “VirtualBox VMs” directory. Don’t worry –
just remember where you extracted the BitCurator directory.
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Oracle VM VirtualBox Manager
Once you’ve installed VirtualBox and the VirtualBox extension pack, start up VirtualBox. If you’ve
never used VirtualBox before, your list of machines (on the left) will be blank.
Tip: You may need to right-click on the VirtualBox icon and select “Run as Administrator”.
Windows machines with certain administrative controls may prevent you from accessing USB
devices (or lock out control of the mouse and keyboard) otherwise.

VirtualBox Manager in Windows

VirtualBox Manager in OS X
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Oracle VM VirtualBox Manager
From the menu bar, select the menu item “Machine -> Add…”, and navigate
to the folder containing .vbox file that you extracted. Choose that file, and
the Virtual Machine should appear in the list within the manager.

Adding a machine (VirtualBox in Windows)

Adding a machine (VirtualBox in OS X)
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VirtualBox Manager: Configuring RAM and Processors
Click on the Settings icon, and select the system tab. We recommend a minimum of
4096MB RAM and 2 processors assigned to the VM. You may wish to change the RAM and
number of processors depending on the hardware that you’re running on. For best
results, select the largest number in the “green” areas for each.
Tip: You’ll need 2 or more processors assigned for VirtualBox to support drag-and-drop.

Configuring the VM (VirtualBox in Windows)

Configuring the VM (VirtualBox in OS X)
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VirtualBox Manager: USB Device Capture
BitCurator depends on a VirtualBox device filter to capture USB devices. In OS X, you’ll find this filter
under the USB tab of the “Ports” icon under “Settings”. In Windows, you’ll find it in the “USB” tab in
settings. You don’t need to do anything here, unless you don’t see an entry under “USB Device Filters”.
If you don’t see an entry, select the USB 3.0 radio button, and then create a new filter by clicking on the
blue icon to the right of the list.
Tip: If you don’t need access to USB devices (for example, if you plan to do analysis of existing borndigital data but no disk imaging), you can delete this filter.

USB filters (VirtualBox in Windows)

USB filters (VirtualBox in OS X)
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VirtualBox Manager: Shared Folders
If you wish to move processed materials back to your host machine from the BitCurator
VM, you can set up a shared folder that both the host and the VM can write to. In the
Shared Folders tab, click the folder with the green “plus” on it to choose a folder on your
host machine to share.
Tip: Select “Automount” but not “Read Only”. When the machine is booted, the folder
will appear in the “Shared Folders and Media” folder on the desktop in the VM.

Shared folders (VirtualBox in Windows)

Shared folders (VirtualBox in OS X) 13

Starting the BitCurator Environment (VM)
Clicking on the green “Start” arrow in the Oracle VM VirtualBox Manager screen will start
the BitCurator environment. You’ll see a startup screen, and then the BitCurator
environment will boot and automatically log in.
Tips:
If you encounter a menu screen on boot, simply hit the Return key to continue.
If you see an error message mentioning virtualization extensions, or “Intel VT-x”, your host
machine’s BIOS does not have virtualization extensions enabled. You’ll need to reboot your
computer, holding down “Del” (or “Esc”, or the “ThinkPad” button, depending on your
machine). Once you’re in the BIOS, locate the correct menu entry and enable the Intel
Virtualization Extensions.
If BitCurator fails to boot for other reasons, it may be due to a “non-optimal setting”
detected for your particular hardware. Try powering off the virtual machine, checking your
settings, and starting again. If you’re still having a problem, let us know on the BitCurator
users group (linked on our site at https://bitcurator.net/).
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Starting the BitCurator Environment (VM)

The BitCurator virtual machine should log in automatically. If you log out or
the machine goes to sleep, the password to log back in is “bcadmin”. You
can also use this password to update installed software, if prompted.
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Getting Started With The Live ISO (Dedicated Install)
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Getting Started With The Live ISO (Dedicated Install)
• Hardware:
– Desktop or laptop with an Intel Core i5 or Core i7 processor (or
AMD equivalent)
– 8GB RAM minimum (16GB or more recommended)
– For best performance, we recommend using an SSD (256GB or
larger) when installing and running BitCurator on a dedicated
machine.

• Software:
– You will need to use an existing machine to write the ISO to a
bootable medium (4GB or larger USB stick, preferably USB 3.0). The
ISO is too large to write to a CD-ROM. We recommend you do not
attempt to write it to a DVD-ROM.
– Instructions for installation are on the following slides.
17

Creating a bootable USB drive (Windows and Mac)
1. Download the current BitCurator ISO image from:
https://github.com/BitCurator/bitcuratordistro/wiki/Releases
2. To create a bootable USB drive using a Windows machine,
follow the instructions at:
https://www.ubuntu.com/download/desktop/create-ausb-stick-on-windows
3. To create a bootable USB drive using a Mac, follow the
instructions at:
https://www.ubuntu.com/download/desktop/create-ausb-stick-on-mac-osx
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Installing BitCurator
• Once you have a bootable USB drive, power down the machine
you wish to install BitCurator on, and plug the USB drive into a
primary USB port (e.g. not a USB hub).
• Power on the machine. On certain PCs, you may need to enter
the BIOS to allow booting from USB drives. Consult the
documentation for your particular machine.
• Allow the machine to boot to the Live desktop. Then, doubleclick on the Installer icon located on the desktop.
Tip: If your drive is appropriately partitioned, BitCurator can be installed alongside
an existing Windows or Linux operating system. The installer will attempt to
automatically identify whether an existing OS is present. Please consult the
existing Ubuntu documentation regarding dual-installs for additional detail.
19

Essential Tools in the BitCurator Environment
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Essential Tools in the BitCurator Environment
The BitCurator Environment provides shortcuts to
commonly used tools, organized into folders on the
desktop:
•

•

•

•

The Imaging and Recovery folder contains tools to
create raw and forensically-packaged disk images
from physical media.
The Forensics and Reporting folder contains
launchers for forensics tools, disk and file system
analysis tools, and report generation utilities.
The Packaging and Transfer folder points to transfer
and accession tools including Bagger, Python-BagIt,
and Grsync
Additional Tools includes other useful software tools
that may be used to inspect and process disk images
and files.
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Adding a Folder for Disk Images and Reports

Right-click anywhere on the desktop, and select New Folder. A folder named
Untitled Folder will appear on the Desktop. Click on the name (or right-click
and select “Rename”) to rename it as SampleData. You will use this location
to store the data produced in the steps described in the following slides.
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Preparing to Image Digital Media
The BitCurator environment has been customized to prevent the base operating
system (Ubuntu) from automatically mounting any media. When a device is
connected, an icon for that device should appear in the Unity Launcher (the
vertical menu bar on the left). Clicking on this icon will mount the disk readonly; we’ll see an example of this in the next few slides.

Tip: If you wish to change the system policy to readwrite, click on the BitCurator Mount Policy applet in the
top right and select that option. The disk icon will turn
red when “Set mount policy to WRITEABLE” is selected,
and all future device mounts will be performed readwrite (until the policy is changed again). Changing the
mount policy does not affect the mount status of
devices already mounted.
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Getting Ready to Image Digital Media
This example* will use an external USB
floppy disk drive and a 3.5” FAT16 (DOS)
formatted floppy disk.
Now that the VM is started up, the device
will be automatically captured when
plugged in and the disk is inserted. Note
that the BitCurator environment will not
automatically mount media items that are
present, but an icon for the hardware will
appear at the bottom of the Unity menu
bar on the left hand side of the screen.
* The process from this point on will be effectively the same
whether you are working with data from a CD, a floppy, a
hard disk, or another device.
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Imaging the Device

Once the device is attached, a disk icon should appear in the menu bar on the left. The
device has not been mounted; this simply indicates the device is recognized by the system.
Double-click on Imaging and Recovery on the Desktop, and then double-click on
Guymager. In this example, the TEAC-brand floppy drive is selected in the picture above. 25

Entering Imaging Metadata

Right click on the device, and select Acquire image. This disk image will be acquired using
the Expert Witness Format (the second option at the top). The five metadata fields starting
with Case number are optional. Don’t forget to select the directory you made on the
desktop in the Image directory field. Finally, provide a name for the image. Then click Start.26

Acquiring the Disk Image

You will see the main dialog state change to Acquisition Running. When the acquisition finishes,
you will see an OK message in the State column.
Tip: The BitCurator environment runs at a resolution of 1024x768 by default. If you wish to see
the whole dialog, just make the window bigger. The resolution should adjust automatically.
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Examining the Image

Quit Guymager, open up the SampleData directory on the desktop, and
observe the two files that have been produced: the .E01 image file, and a
.info file with log information produced by Guymager.
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Safely removing a device from the system

Now that the disk has been imaged, you can eject it from the system. Note that even
though it’s not mounted, you will still want to do this so the operating system knows
it’s no longer available. Right-click on the disk icon in the doc and click Safely remove.
You can now unplug your drive, or eject the disk.
Tip: Your disk icon may appear different from the one shown above.
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Processing the file system, carving data, and
generating reports

Double-click on the Forensics and Reporting folder, and then double click on
the BitCurator Reporting Tool launcher. You’ll see a window pop up that
should match the picture shown above.
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Processing the file system, carving data, and
generating reports

The Run All tab will allow you to carve the raw disk contents for features of
interest, generate a DFXML listing of the file system hierarchy, match features to
files within the file system, and generate high-level reports. Click on Launch
BEViewer to run bulk_extractor before proceeding.
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Generating Feature Reports with bulk_extractor

BEViewer is the graphical front-end to bulk_extractor. Together, these tools allow
you to identify various features of interest contained within the bitstream
extracted from the source media, such as SSNs, email addresses, EXIF metadata,
and others.
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Generating Feature Reports with bulk_extractor

Click on the Tools menu in the top of the window, and select Run
bulk_extractor. This will bring up a dialog that allows you to select which
scanners to run, and where to generate the report directory.
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Generating Feature Reports with bulk_extractor

Using the “…” icons to the right of the Image File and Output Feature Directory
text boxes, select the image file you generated earlier and tell bulk_extractor to
output the report in a new directory bulk-extractor-output, within the
SampleData directory on the desktop.
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Generating Feature Reports with bulk_extractor

Click on Submit Run at the bottom of the dialog, and you will see a new dialog
appear, indicating the progress made so far. This may take a while for large
images. Be patient!
Tip: Additional processors assigned to the VM will improve performance.
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Viewing the bulk_extractor Report
Once the process has
completed, the report directory
will be available in the relevant
location (in our case, the
directory “bulk-extractoroutput” within SampleData).
The features identified can also
be viewed in the main Bulk
Extractor Viewer window, by
clicking on the report name in
the “Reports” subwindow.
Tip: For the small disk image
shown here, relatively few of
the possible reports are shown.
Your list may include a range of
additional reports.
Tip: The next time you run bulk_extractor viewer (BEViewer), existing reports should remain available in
the left hand column. If you need to open a report you created in a previous run, simply select “Open
Report” in the “File” menu, and navigate to the “report.xml” file in the appropriate bulk_extractor
36
output directory.

Processing the file system, carving data, and
generating reports

With the bulk_extractor run completed, the remaining entries in the Run All tab in the BitCurator Reporting
tool allow us to automate the process of (1) running fiwalk, (2) running the annotation tool to link
bulk_extractor features to files within the file system, and (3) generating the BitCurator reports. We’ll step
through the process in the next few slides.
Tip: Appendix A shows how to run these tools individually using the other tabs.
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Processing the file system, carving data, and
generating reports

Click on the box with three dots next to the “Image File” entry, and navigate
to the sample image (sampleimage.E01) we created in our SampleData
directory on the Desktop earlier.
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Processing the file system, carving data, and
generating reports

The image file you selected should now appear under the “Image File” entry.
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Processing the file system, carving data, and
generating reports

Follow the same process for the “Bulk Extractor Feature Directory” entry. We
previously created the “bulk-extractor-output” directory within the
“SampleData” directory on the desktop.
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Processing the file system, carving data, and
generating reports

Finally, assign an output directory for the reports that will be generated. Note
that you should not click “Create Folder”. Simply navigate to the desired base
directory (in this case, /home/bcadmin/Desktop/SampleData) and type in the
name of a new folder to store the reports in. Then, click Save.
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Processing the file system, carving data, and
generating reports

Now, click “Run”. Be patient! It may take some time for each of the steps to run on larger images.
Tip: If you’re analyzing a raw disk image rather than a forensically-packaged one, BitCurator will
not currently produce PREMIS output.
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Examining Some of the Reports
Open the BitCurator reports directory, and
examine some of the files. You’ll find
visualizations, .xlsx transcriptions of file
system metadata, high level reports on file
types, and overviews of features identified
by bulk extractor.
bc_format_bargraph.pdf – file format histogram
bulk_extractor_report.pdf – high-level overview of
feature locations on disk
fiwalk_deleted_files.pdf – shows paths to any deleted
materials found in a given partition
fiwalk-output.xml.xlsx - Excel version of the DFXML
output (file system metadata)
fiwalk_report.pdf – high-level overview of file system
characteristics
format_table.pdf – long-form file format names for
formats shown in bargraph
premis.xml – PREMIS preservation metadata
43

What We’ve Done So Far
Closing any open windows, let’s open
the “SampleData” directory on the
desktop and review what we’ve
produced so far:
•

A sample image (sampleimage.E01)

•

A fiwalk XML report
(sampleimage.xml)

•

Bulk extractor output (in the bulkextractor-output directory)

•

The annotated output, linking bulk
extractor features to files (in the
annotated-features directory)

•

A set of human-readable reports
for our sample image (in the
reporting-output directory)
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Mounting a disk image to browse the contents

BitCurator includes scripts in the context (right-click) menu that allow you to
mount and unmount disk images. Simply right click on the image file, and
select Mount Disk Image or Unmount Disk Image.
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Mounting a disk image to browse the contents

You’ll see a disk icon appear on the desktop corresponding to the mounted image. If a disk
image does not appear on the desktop, one of two things occurred: no file system was found
on the disk image, or an unrecognized file system was encountered.
Tip: To unmount, right-click on the disk image, not the mounted disk icon on the desktop.
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Exporting Files from a Disk Image Using the BitCurator
Disk Image Access Tool

The BitCurator environment includes a standalone tool for access to the contents of file disk
images, the BitCurator Disk Image Access tool. This tool can be found in the Forensics and
Reporting folder on the desktop.
Tip: This tool uses the icat utility provided by The Sleuth Kit to extract files directly from raw
and forensic disk image formats. Extracting lots of files (or large files) may take some time!
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Exporting Files from a Disk Image Using the BitCurator
Disk Image Access Tool

Clicking on the folder icon in the toolbar will bring up a prompt to load a disk image. The disk
image will be automatically processed, and image information (if available) will be presented in
the top-right dock widget. Files in the disk image may be selected manually or by clicking the
Select All icon in the toolbar. Files may be exported using the Export icon (the paper plane to the
left of the Cancel icon).
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Exporting Files from a Disk Image Using the BitCurator
Disk Image Access Tool

Hovering your mouse over the title bar will bring up a menu. The Edit menu
includes options to select and deselect only the allocated or only the deleted
files.
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Exporting Files from a Disk Image Using the BitCurator
Reporting Tool

Tip: Just as with Windows Explorer and the OS X finder, Ubuntu hides some types of directories
and files from regular view in folders on the Desktop (including those with names that begin with
a “.”). To fully view all of your exported files, select Show Hidden Files from the View menu of the
folder where they have been exported.
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Other Tools: Browse Legacy HFS (early Macintosh file
system) images

Many of the tools in BitCurator (including the BitCurator Reporting Tool and Disk
Image Access Tool) use The Sleuth Kit to process disk images. TSK cannot process
legacy HFS (early Macintosh) file systems. BitCurator includes HFSExplorer to
support browsing and file export from HFS file systems.
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Other Tools: Identify and Delete Duplicates with
FSLint

BitCurator includes FSLint, which allows you to rapidly scan directory contents
to identify duplicates, and delete selected items from the subsequent
duplicate lists.
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Other Tools: pyExifToolGUI

pyExifToolGUI is a graphical front-end for ExifTool. It allows you to view, edit,
and manually export data from many graphical file formats.
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Other Tools: FIDO

In the “Additional Tools” directory on the desktop, you will find a launcher for
the (command line only) FIDO tool for file format analysis.
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Other Tools: RegRipper

RegRipper extracts information and create reports from Microsoft Windows registry files.
RegRipper is a command-line tool written in Perl.
You can find it in /usr/share/regripper, and view options for running it using the command
“perl rip.pl” within that directory (or use the desktop launcher in Forensics and Reporting).
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Other Tools: Python BagIt Library

In the Packaging and Transfer directory on the desktop, you will find a
launcher for the Python Bagit library used to manage and package collections
of files and associated metadata.
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Other Tools: Grsync

In the Packaging and Transfer directory on the desktop, you will find a launcher
for Grsync, a graphical interface for the rsync utility. Grsync provides facilities
for permissions-preservation, halt-on-failure, and many other advanced
options.

57

Other Tools: ClamTK (GUI for Clam Antivirus)

In the Additional Tools directory on the desktop, you will find a launcher for
ClamTK, the GUI front-end to the ClamAV antivirus service.
The Scan menu (and the related icons under “Analysis”) will allow you to scan
specific files, directories, mounted disks, and other devices.
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Other Tools: Running fiwalk with the ClamAV plugin to
identify viruses and malware (command-line only)
The fiwalk tool has a plugin architecture allowing you to run external tools over file items it
identifies. In a terminal, enter the ficlam directory by typing:
cd /home/bcadmin/.ficlam
This directory contains a fiwalk ClamAV plugin from The Sleuth Kit (ficlam.sh) and the
associated configuration file. You can generate fiwalk output that includes virus scan results
by typing:
fiwalk –c clamconfig.txt –X /home/bcadmin/Desktop/myoutput.xml
/home/bcadmin/Desktop/myimage.E01
In this example, “myoutput.xml” is where you’d like the DFXML output to appear, and
myimage.E01 is the name of your disk image. Change these names and directory paths as
needed.
File entries in the DFXML that are clean will appear as follows (at the end of each fileobject
entry):
<!-- plugin_process -->
<clamav_infected>0</clamav_infected>
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Other Tools: TestDisk

TestDisk is an tool used to recover “lost” partitions and analyze damaged disks. More
info can be found at http://www.cgsecurity.org/wiki/TestDisk.
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Other Tools: PhotoRec

PhotoRec is a tool used to recover damaged and “lost” files. More info can be found at
http://www.cgsecurity.org/wiki/PhotoRec.
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Other Tools: hashdb

The hashdb tool may be used to find data in raw media using cryptographic hashes
calculated from blocks of data. The hashdb manual can be found in the
Documentation and Help folder on the Desktop.
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Other Tools: md5deep (and hashdeep)

The md5deep tools may be used to compute MD5, SHA-1, SHA-256, Tiger, and Whirlpool
message digests over any set of files. The toolset supports recursive operation, comparison
to existing hashsets, and time estimation when running over large sources.
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Other Tools: nwipe (securely wipe media)

The nwipe tool in “Additional Tools” allows you to securely wipe (overwrite with zeros
or random data) physical devices. WARNING! This tool runs as root and allows you to
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wipe any device, including the disk the system is running on. Use with caution!

Other Tools: hardinfo (System Profiler & Benchmark)

The hardinfo tool displays system information and can generate reports describing
how the system is configured. It also provides basic benchmarking facilities.
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Navigation Tips: Open a location in a terminal

When browsing the file system using Nautilus, you can open any location in a terminal
simply by right-clicking anywhere (not on a file or folder) in the browser window and
selecting Open in Terminal.
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Find Updated BitCurator Information and
Documentation Online
• News and social media updates on
BitCurator projects
• Project histories
• Personnel and contributors
https://bitcurator.net

• Documentation and walkthroughs
• Workflows, scripts and BitCurator
Consortium member contributions
https://confluence.educopia.org/display/BC
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APPENDIX A: Running BitCurator reporting
tools individually

68

Producing a DFXML report of the file system contents
using the ‘fiwalk’ tab.

Double-click on the Forensics and Reporting folder, and then double click on
the BitCurator Reports launcher. You’ll see a window pop up that should
match the picture shown above. Select the Fiwalk XML tab.
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Producing a DFXML report of the file system contents
using the ‘fiwalk’ tab.

Fiwalk needs to know where the disk image file is. It also needs to know where to
create the DFXML output file. Click on the ‘…’ box to the right of the Image File
text edit box, and navigate to the directory containing the image we just created.
Select ‘sampleimage.E01’ and click Open.
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Producing a DFXML report of the file system contents
using the ‘fiwalk’ tab.

Now click on the box with three dots to the right of the Output XML File text
area, and navigate to the same directory on the desktop. Type in
“sampleimage.xml” under Name at the top, and click Save.
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Producing a DFXML report of the file system contents
using the ‘fiwalk’ tab.

The main window should now have both the Image File and the Output XML
File fields filled with the appropriate locations. Click Run, and fiwalk will run.
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Producing a DFXML report of the file system contents
using the ‘fiwalk’ tab.

The resulting DFXML file can be found in the SampleData directory created
earlier on the desktop. Examine the contents by double-clicking on it.
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Matching Features to Files
Bulk Extractor extracts features
from a disk image by scanning the
raw bitstream – not by parsing the
file system.
In order to determine which files
these features appear within (or if
they appear on an area of the disk
not associated with the file
system), we need to run an
additional tool.
For the next step, either maximize
the BitCurator Reports GUI you
minimized earlier, or restart it from
the Forensics and Reporting
directory on the desktop. Click on
the Annotated Features tab.
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Matching Features to Files
In order to annotate the features – that is, identify which features belong to
which files within the file system – we need to know five things:
1
2
3
4
5

Which feature reports to work from (the BitCurator Reports GUI uses all
of them; to select specific reports, there is a command-line option.
The location of the image file.
The location of the fiwalk output.
The location of the bulk_extractor output.
Where to generate the reporting output. In this case, a new directory
called annotated-files will be created in the SampleData directory on the
desktop.

Selection of these items is shown in the following slides.
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Matching Features to Files

In the screenshot shown here, the image file and bulk extractor output directory
have been selected. A new directory has been specified inside the SampleData
directory for the annotated features.
Tip: The Bulk Extractor python directory is optional.
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Matching Features to Files

Click Run, and the tool will run. Scroll down in the Command Line Output
window and you should see a Success message as indicated above.
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Generating BitCurator Forensic Reports
Now that we have a disk image, an
XML representation of the file system
contents, a directory of feature files,
and a set of reports that match
features to filenames, we can run the
BitCurator reporting tool.
Click on the ‘Reports’ tab in the
BitCurator GUI.
The “Generate Report” program
needs to know about four things:
1. Where the fiwalk output is
2. Where the annotated bulk
extractor report directory is (we
generated this in the previous
step)
3. Where we want to generate the
output.
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Generating BitCurator Forensic Reports

As in steps for the previous tabs, use the grey squares to select the fiwalk XML file that we
created in the SampleData directory, the annotated features directory, and – finally – to
specify a new output directory for the BitCurator reports. In the image above, we’ve chosen
to place this new directory in SampleData, and call it “bc-reports”.
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Generating BitCurator Forensic Reports

Click Run, and you will see output appear in the Command Line Output box
indicating success or notifying you if any error occurs.
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APPENDIX B: Using BitCurator tools on
the command line
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B1. Fiwalk: Producing a DFXML report of the File
System Contents
The fiwalk tool needs to know three things:
1
2
3

Whether you want to run “file” to identify the file formats in the file system
(the ‘- f’ option).
The name of the DFXML file that will be produced (‘-X’, followed by the file
path).
The name of the image to process.

The command to run is shown below.
Tip: “~/” at the beginning of each path tells the program to start looking for
these folders in the user’s home directory.
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B2. Identify_filenames.py: Matching Features to Files
The “Identify Filenames” program needs to know five things:
1
2
3
4
5

Which feature reports to work from (here we’ve used the “all” flag to tell it to use all of
them)
Where the image file is (“—image_filename [FILE LOCATION]”)
Where the fiwalk output is (“—xmlfile [FILE LOCATION]”)
Where the bulk extractor output is (just the location)
Where we want to generated the output. In this case, we’re telling it to make a new
directory called “beannotated” in our SampleData directory on the desktop.
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B3. BitCurator reporting: Running the Report
Generator
The “Generate Report” program needs to know three things:
1
2
3

Where the fiwalk output is (“—fiwalk_xmlfile [FILE LOCATION]”)
Where the annotated bulk extractor report directory (the one we
generated in the last step) is (“—annotated_dir [DIRECTORY
LOCATION]”)
Where we want to generated the output. In this case, we’re telling it to
make a new directory called “bcsamplereports” in our SampleData directory
on the desktop.

You will see a several prompts for configuration. For now, use the defaults (typing
“Y” and enter for the first prompt, and enter for the second).
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